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Abstract 
 
First conceived in 1850, HDR, or high-dynamic-range, photography 
was introduced to Photoshop in Adobe Creative Suite 2 (Photoshop 9) 
as the Merge to HDR function. HDR has recently been incorporated 
into newer digital SLR cameras including the Pentax K and Sony Alpha 
line. HDR attempts to overcome the limited density ranges of 
photography and print as compared to the human eye. The technique 
involves combining multiple exposures that capture the highlight and 
shadow detail of high-contrast scenes, such as sunsets or brightly 
illuminated buildings against dark backgrounds. Online image galleries 
showcase HDR’s aesthetic affects, in which photos often have a 
posterized or surrealistic appearance. 
 
This study was performed to determine the value of HDR photography 
in capturing low-key subjects, such as products for publication in 
magazines, catalogs, and newspapers—specifically, whether HDR 
would bring out more highlight and shadow detail without creating a 
posterized look. The authors compared conventional Camera Raw 
(DNG) captures with HDR captures made automatically by a Pentax K-
r DSLR and manually in Photoshop. Captures were made on a studio 
copy stand with a 3M/Stouffer 12-step grayscale at the edge that was 
used to plot a tone reproduction curve comparing percent dot area in 
Photoshop with density of the original. 
 
HDR compressed the tone reproduction curve and also brought out 
more shadow contrast in low-key images. By subjectively evaluating 
proofs of conventional and HDR photos, the authors observed that 
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HDR images can be captured of low-key subjects that have more detail 
but avoid a posterized look. However, HDR processing added about 22 
sec. to each camera HDR photo and 48 sec. to each Photoshop HDR 
merge. In a 100-photo catalog scenario where each subject took 2 
minutes to set up, HDR could add 10–25% to production time. 
 

Introduction 
 

First conceived in 1850, HDR, or high-dynamic-range, photography 
was introduced to Photoshop in Adobe Creative Suite 2 (Photoshop 9) 
as the Merge to HDR function. HDR has recently been incorporated 
into newer digital SLR cameras including the Pentax K and Sony Alpha 
line. HDR attempts to overcome the limited density ranges of 
photography and print as compared to the human eye. The technique 
involves combining multiple exposures that capture the highlight and 
shadow detail of high-contrast scenes, such as sunsets or brightly 
illuminated buildings against dark backgrounds. Online image galleries 
showcase HDR’s aesthetic affects, in which photos often have a 
posterized or surrealistic appearance. 
 
This study was performed to determine the value of HDR photography 
in capturing low-key subjects, such as products for publication in 
magazines, catalogs, and newspapers—specifically, whether HDR 
would bring out more highlight and shadow detail without creating a 
posterized look. 
 
The authors compared conventional Camera Raw (DNG) captures with 
HDR captures made automatically by a Pentax K-r DSLR and 
manually in Photoshop. Captures were made on a studio copy stand 
with a 3M/Stouffer 12-step grayscale at the edge that was used to plot a 
tone reproduction curve comparing percent dot area in Photoshop with 
density of the original. 
 

Literature Review 
 

Little technical literature appears to exist on the practical use of HDR 
photography for publication. Sammons (2010) instructional book 
shows samples of high-contrast indoor and outdoor scenery, captured 
with both conventional and HDR photography. The author points out 
that HDR works best for high-contrast scenes where the user wants to 
see all visible detail. This principle is also important in product 
photography, where the prospective customer wants to see detail in 
products. 
 



 
Moughamian (2010) explains Photoshop’s Merge to HDR Pro 
automation function (File > Automate). He points out that 3–5 
exposures work best for HDR photography. 
 

Procedure 
 
1. Using a Pentax K-r CMOS 12-megapixel digital SLR camera with 

a Pentax 18–55-mm zoom lens, the authors photographed various 
subjects containing low-key and high-key elements, including a 3D 
black greeting card, a feather table decoration, and some dark 
statues (Figure 1) using conventional and HDR photography. A 
3M/Stouffer 12-step grayscale was included with each exposure 
for use in plotting a tone reproduction curve. Images for merge to 
HDR in Photoshop were captured with a ±0.5, 1.0, and 1.5 EV 
bracket. 

 
2. HDR photography was done using Photoshop CS5’s File > 

Automate > Merge to HDR Pro function with default settings 
(Figure 2) and with the built-in HDR mode on the Pentax K-r 
DSLR camera. 

 
 a. Photoshop was used to merge photos captured on the Pentax 

K-r as Camera Raw digital negative (DNG) files. 
 
 b. The K-r’s HDR settings include 5 modes: HDR-Auto, HDR, 

HDR1, HDR2, and HDR3 (Figure 5). Each successive setting 
has a wider exposure range, meaning it captures a wider range 
of density but also produces a more posterized look. HDR 
captures can only be saved in JPEG format. 

 
3. Captures were opened in Photoshop, and the Window > Info 

palette was used to read the percent dot area of each of the 12 
grayscale steps. Dot areas, along with the original grayscale 
densities, were saved in Excel and used to plot a tone reproduction 
curve, “Density of Original vs. Percent Dot Area of Reproduction.” 

 
4. After opening in Photoshop, captures were visually evaluated on a 

calibrated Apple iMac display. The authors compared overall 
lightness and darkness, highlight and shadow detail, and tone and 
color match to the original, with special reference to the 
“posterized” look that characterizes some HDR photos. 

 
5. The authors also captured a 140-patch Macbeth ColorChecker SG 

target with the K-r camera’s HDR setting and used it to make a 



camera ICC profile with X-Rite’s i1 Match software. The profile 
was applied to images using Photoshop’s Edit > Assign Profile 
command. Delta-E color difference was compared between the 
original target’s LAB values and those of the unprofiled and 
profiled captures. 

 
6. To assess the effects of HDR photography on productivity, the 

authors timed the exposure steps with a stopwatch. Producing 
HDR images with Photoshop is a two-step process where images 
are first opened in a preview window and then merged to make a 
single HDR photo. The Pentax K-r camera’s HDR feature is also a 
two-step process in which 3 exposures are made and then merged 
in the camera, during which a “Processing image” message with 
progress bar is displayed. The time to produce one Photoshop 
HDR image and one Pentax K-r HDR image was compared with a 
baseline of exposing and opening a JPEG image in Photoshop. 
Results were compared using a hypothetical catalog job consisting 
of 100 images. 

 
Results and Discussion 

 
Visual evaluation. Examining captures on-screen, the authors 
observed that HDR photos of products could be made that bring out 
more detail than conventional photos while avoiding the posterized 
look characteristic of HDR photography. 
 
Tone reproduction. Tone reproduction curves (Figure 3) showed that 
HDR compresses the tonal range of photos, producing a curve that is 
flatter and has less contrast than with conventional photos. The wider 
the exposure range of original photos, or the higher the level of camera 
HDR, the flatter is the tone reproduction curve and the less contrast 
there is in the reproduction (Figure 4). 
 
ICC profiling. The authors observed that applying an ICC camera 
profile to HDR photos corrects hues and provides a closer match to the 
original subject (Figure 5). Comparing the average ∆E color difference 
between the original Macbeth ColorChecker SG target and captures 
thereof, the unprofiled Pentax K-r had a ∆E of 4.95 for a conventional 
photo and 5.30 for an in-camera HDR photo, which were not 
statistically significant. Assigning a profile reduced the conventional 
capture’s ∆E to 2.67 and the HDR capture’s ∆E to 3.41. 
 
Effect on Productivity. Timed with a stopwatch, a 6-megapixel in-
camera HDR on the Pentax K-r DSLR took 2.52 sec. to expose and 
10.24 sec. to process, for a total of 12.76 seconds (Table 1). Merging 



three 12-MP DNG files to HDR in Photoshop required 15.57 sec. to 
open the files and 13.35 sec. to merge them on a 2.4-GHz MacBook, 
for a total of 28.92 sec. The time was reduced to 20.47 sec. by using 6-
MP JPEG images. In a catalog production scenario requiring 100 
images, each of which takes 2 minutes to set up (including positioning, 
lighting, zoom, and exposure), capturing with in-camera HDR would 
add 21.27 min., or about 11%, to the 3.33-hr. production time. Merging 
HDR in Photoshop would add 34 minutes, or 17% more time, for 6-MP 
JPEGs and 48 min., or 24% more time, for 12-MP DNG captures. 
Service providers would need to weigh the cost of the additional 
production time against the benefits of HDR in showing more image 
detail that could be important for consumers. 
 

Table 1. Time    
 1 Photo 100 Photos1 % Job Time 
Conventional 
 Open 6-MP JPEG 
 Open 12-MP DNG 

 
1.07 sec. 

5.84   

 
1.78 min. 

9.73 

 
0.89% 
4.87% 

In-camera HDR 
 Expose 
 Process 
 Total 

 
10.24 sec. 

2.52 
12.76 

 
4.20 min. 

17.07 
21.27 

 
 
 
10.63% 

Photoshop HDR from 6-MP JPEG 
 Open JPEG 
 Merge JPEG 
 Total 

 
7.91 sec. 
12.56 
20.47 

 
13.18 min. 

20.93 
34.12 

 
 
 
17.06% 

Photoshop HDR from 12-MP DNG 
 Open DNG 
 Merge DNG 
 Total 

 
15.57 sec. 

13.35 
28.92 

 
25.95 min. 

22.25 
48.20 

 
 
 
24.10% 

1 Assumes 100-photo job with 2 min./photo setup time or 3.33-hr. production time. 
 

Conclusions 
 
The authors concluded that HDR photography, using either in-camera 
settings or Photoshop’s Merge to HDR Pro automation, can be used to 
capture product images that show more detail while avoiding the 
characteristic posterized look. Applying an ICC camera profile slightly 
increases the color match to the original. HDR does increase production 
time. Depending upon setup time, it could add 10% or more to the time 
required to complete a large job. 
 
After preparing the poster session that led to this paper, the authors 
attended the 63rd Annual TAGA Conference keynote presented by 
Narasimhan (2011). The speaker mentioned that cameras aim for color 
intensity instead of color accuracy, thus the middle image used when 
making an HDR photo focuses on color intensity since it is the 
“standard” photo that a camera would take. Once this middle picture is 



removed form the equation and just the high key and low-key photos 
are combined the middle is interpolated by Photoshop and actually goes 
on to create a very color-accurate image. By removing the photo that 
focuses on color intensity we were able to remove the cartoonish effect 
of the photos and introduce a much more color accurate capture. 
 

Ideas for Further Research 
 
While working on this project the authors recognized several additional 
areas where research on HDR photography could be helpful: 
 
1. How does in-camera HDR compare on different cameras, such as 
Pentax and Sony? 

 
2. How does the dynamic range of HDR photography compare with 
that of Camera Raw, which also captures a wide range of highlight and 
shadow detail? 
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Figures 
 

 
Figure 1a. Subjects used to study the effects of HDR photography for use 
in capturing products. 

 

 

 
Figure 2. HDR modes on the Pentax 
K-r digital SLR camera. 

Figure 3. Merge to HDR funciton in 
Photoshop. 

 



  
Figure 4a. Unprofiled HDR capture. Figure 4b. Profiled HDR capture. 

 



   
Figure 5a. Normal 
photo 

Figure 5b. Pentax K-r 
HDR Automatic 

Figure 5c. Pentax K-r 
HDR 

   
Figure 5d. Pentax K-r 
HDR-1 

Figure 5e. Pentax K-r 
HDR-2 

Figure 5f. Pentax K-r 
HDR-3 

 
 



  
Figure 6a. Unprofiled HDR capture. Figure 6b. Profiled HDR capture. 

 


